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MCP2120/MCP2150
DEVELOPER’S KIT USER’S GUIDE

Preface
INTRODUCTION

The MCP2120/MCP2150 Developer’s Kit demonstrates the capabilities of the 

MCP2120 and MCP2150 infrared communication products. Items discussed in this 

chapter include:

• About This Guide

• Recommended Reading

• The Microchip Web Site

• Customer Support

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools 

and documentation are constantly evolving to meet customer needs, so some actual 

dialogs and/or tool descriptions may differ from those in this document. Please refer 

to our web site (www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom 

of each page, in front of the page number. The numbering convention for the DS 

number is “DSXXXXXA”, where “XXXXX” is the document number and “A” is the 

revision level of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE 

on-line help. Select the Help menu, and then Topics to open a list of available on-line 

help files.
© 2005 Microchip Technology Inc. DS51246C-page 1
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OVERVIEW

The MCP2120 and MCP2150 Developer’s Board can be connected to either a PC via 

the DB9 connector, or to another system (such as a PICDEM™ 2 board) via the four 

pin header.

The MCP2120/MCP2150 Developer’s Kit comes with the following:

1. Two MCP2120 Developer Boards.

2. One MCP2150 Developer Board.

3. Two serial cables.

4. One 9V power supply, with power cord.

5. One pair 18″ (45 cm) power jumper cables.

6. Sample kit (one MCP2120 device and one MCP2150 device) – not shown.

Each kit comes with one MCP2120 device and one MCP2150 device. This 

allows a prototype system to be developed that can be used with an MCP2120 

Developer’s Board or an MCP2150 Developer’s Board.

7. MCP2120/MCP2150 Developer’s Kit User’s Guide (this document) – not shown.

If you are missing any part of the kit, please contact your nearest Microchip sales 

office listed in the back of this publication for help.

FIGURE 1-1: MCP2120/MCP2150 DEVELOPER’S KIT    
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Preface
ABOUT THIS GUIDE

Document Layout

This document describes the MCP2120/MCP2150 Developer’s Kit and tutorials, giving 

the user a brief overview of Microchip’s MCP2120 and MCP2150 family of infrared 

communication products. Detailed information on the individual device may be found in 

the device’s respective data sheet. Detailed information on the PICDEM 2 development 

board may be found in the PICDEM 2 User’s Guide (DS30374). The manual layout is 

as follows:

• Chapter 1: Getting Started – This chapter gives an overview of the MCP2120 

and MCP2150 Developer’s Boards, the hardware features of each Developer’s 

Board, the system configurations that can be used to demonstrate the MCP2120 

and MCP2150 devices, and the PC requirements.

• Chapter 2: MCP2120 Tutorial – This chapter provides a detailed description of 

the steps to get the MCP2120 Developer’s board operating. These steps include 

the configuration of the Developer’s boards and the Terminal Emulation program 

(Hyperterminal) used on the PC.

• Chapter 3: MCP2150 Tutorial – This chapter provides a detailed description of 

the steps to get the MCP2150 Developer’s board operating. These steps include 

the configuration of the Developer’s boards, the Terminal Emulation program 

(Hyperterminal) used on the PC and the installation and configuration of the PC 

IrDA™ standard drivers.

• Chapter 4: Using PICDEM™ 1 or PICDEM 2 Board as Host – This chapter 

discusses the use of the PICDEM boards as a demonstration platform as a Host 

Controller for an MCP2120 Developer’s Board or an MCP2150 Developer’s 

Board. This chapter makes reference to Application Notes which contain 

demonstration code.

• Appendix A: Hardware Description – This appendix describes in detail the 

hardware of the MCP2120 Developer’s board and MCP2150 Developer’s board. 

This includes the component layout of each board (silkscreen) and the schematic 

of each board.
© 2005 Microchip Technology Inc. DS51246C-page 3
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Conventions Used in this Guide

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 

dialog

“Save project before build”

Underlined, italic text with 

right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

‘bnnnn A binary number where n is a 

digit

‘b00100, ‘b10

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier font:

Plain Courier Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Italic Courier A variable argument file.o, where file can be 

any valid filename

0xnnnn A hexadecimal number where 

n is a hexadecimal digit

0xFFFF, 0x007A

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 

character: { | }

Choice of mutually exclusive 

arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 

user

void main (void)
{ ...
}

DS51246C-page 4 © 2005 Microchip Technology Inc.



Preface
RECOMMENDED READING

The following Microchip documents are available and recommended as supplemental 

reference resources.

MCP2120 Data Sheet (DS21618)

MCP2150 Data Sheet (DS21655)

MPASM™ User’s Guide with MPLINK™ Linker and MPLIB™ Library (DS33014)

PRO MATE® II User’s Guide (DS30082)

PICSTART® Plus User’s Guide (DS51028)

MPLAB® ICE User’s Guide (DS51159)

MPLAB® ICD User’s Guide (DS51184)

AN756, “Using the MCP2120 for Infrared Communication” (DS00756)

AN758, “Using the MCP2150 to Add IrDA® Standard Wireless Connectivity” (DS00758)

TB046, “Connecting the MCP2150 to the Psion Operating System” (DS91046)

TB047, “Connecting the MCP2150 to the Windows® CE Operating System” (DS91047)

TB048, “Connecting the MCP2150 to the Windows® Operating System” (DS91048)

TB049, “Connecting the MCP2150 to the Palm™ Operating System” (DS91049)

THE MICROCHIP WEB SITE

Microchip provides online support via our WWW site at www.microchip.com. This web 

site is used as a means to make files and information easily available to customers. 

Accessible by using your favorite Internet browser, the web site contains the following 

information:

• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 

latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQ), technical 

support requests, online discussion groups, Microchip consultant program 

member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 

press releases, listing of seminars and events, listings of Microchip sales offices, 

distributors and factory representatives
© 2005 Microchip Technology Inc. DS51246C-page 5



MCP2120/MCP2150 Developer’s Kit User’s Guide
CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

• Development Systems Information Line

Customers should contact their distributor, representative or field application engineer 

(FAE) for support. Local sales offices are also available to help customers. A listing of 

sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support@microchip.com

In addition, there is a Development Systems Information Line which lists the latest 

versions of Microchip's development systems software products. This line also 

provides information on how customers can receive currently available upgrade kits.

The Development Systems Information Line numbers are: 

1-800-755-2345 – United States and most of Canada

1-480-792-7302 – Other International Locations
DS51246C-page 6 © 2005 Microchip Technology Inc.
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Chapter 1.  Getting Started
1.1 INTRODUCTION

This chapter covers an overview of the MCP2120 and MCP2150 Developer’s Boards 

features, the system configurations that they can be used in and the system 

requirements for the tutorials.

1.2 HIGHLIGHTS

Items discussed in this chapter are:

• MCP2120 Developer’s Board Features

• MCP2150 Developer’s Board Features

• System Configurations

• PC Requirements

1.3 DEVELOPER BOARD FEATURES

1.3.1 MCP2120 Developer’s Board Features

The MCP2120 Developer’s Board, as shown in Figure 1-1, has the following hardware 

features:

1. On-board +5V regulator for direct input from 9V, 750 mA AC/DC wall adapter or 

9V battery. 

2. Hooks for a +5V, 750 mA regulated DC supply.

3. DB-9 connector and associated hardware for direct connection to MCP2120 

UART (DB-9 interface requires RS-232 signal levels).

4. Four-pin header connection to UART interface (Header requires TTL level 

signals).

5. Two jumpers to select source of UART signals. Either DB-9 connector or the 

four-pin header.

6. Three jumpers to select desired baud rate.

7. Green power-on indicator LED.

8. Two IR Transceiver options (two jumpers select transceiver).

9. Jumper to disable MCP2120 device operation.

10. Hardware and Software Baud selection.

11. Jumper for Software Baud control when using RS-232C interface.

12. Socketed crystal.  

Note: A schematic of the MCP2120 Developer’s Board is shown in Figure A-5
© 2005 Microchip Technology Inc. DS51246C-page 7
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FIGURE 1-1: MCP2120 DEVELOPER’S BOARD HARDWARE
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Getting Started
1.3.2 Selecting UART Source and Optical Transceiver Interface

Figure 1-2 shows two pairs of jumpers used to route signals to and from the MCP2120.

Jumpers J1 and J4 are used to determine the source of the signals used by the UART 

interface. When the header has the pins closest to the “DB9” label jumpered to the 

center pin, the DB9 is the source of the UART signal. When the header has the pins 

closest to the “Header” label jumpered to the center pin, the four-pin header is the 

source of the UART signal.

Jumpers J6 and J7 are used to determine the source and destination of the infrared 

data signals used by the interface between the MCP2120 and Optical Transceiver. 

When the header has the pins closest to the “Integrated Transceiver” label jumpered to 

the center pin, the integrated transceiver is used. When the header has the pins closest 

to the “Component Transceiver” label jumpered to the center pin, the component 

transceiver logic is used.

FIGURE 1-2: MCP2120 SELECTING SOURCES
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1.3.3 Selecting Baud Rate

Figure 1-3 shows the three Baud Rate Select Jumpers (JP3:JP1) and the baud rate 

formula that is specified (baud rate dependant on MCP2120 operational frequency). 

Table 1-1 shows the baud rates for some crystal frequencies.

FIGURE 1-3: MCP2120 BAUD RATE

TABLE 1-1: HARDWARE BAUD RATE SELECTION VS. FREQUENCY

FOSC Frequency (MHz)

BAUD2:BAUD0 0.6144 (1) 2.000 3.6864 4.9152 7.3728 14.7456(2) 20.000(2) Bit Rate

000 800 2604 4800 6400 9600 19200 26042 FOSC / 768

001 1600 5208 9600 12800 19200 38400 52083 FOSC / 384

010 3200 10417 19200 25600 38400 78600 104167 FOSC / 192

011 4800 15625 28800 38400 57600 115200 156250 FOSC / 128

100 9600 31250 57600 78600 115200 230400 312500 FOSC / 64

Note 1: An external clock is recommended for frequencies below 2 MHz.

2: For frequencies above 7.5 MHz, the TXIR pulse width (MCP2120 Data Sheet, 
Electrical Specification, parameter IR121) will be shorter than the minimum pulse width 
of 1.6 ms in the IrDA standard specification.
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Getting Started
1.3.4 UART Mode

Figure 1-4 shows the jumper which determines if the MCP2120 Developer’s Board is 

to be used in Hardware Baud operation, or Software Baud operation. When in Software 

Baud operation, an additional signal is required, Request To Send (RTS), which is used 

to drive the RESET pin low to cause a change of baud rate to occur.

FIGURE 1-4: MCP2120 UART
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1.3.5 Disabling the MCP2120

Figure 1-5 shows the jumper, JP4, which will enable or disable the MCP2120 device. 

When the MCP2120 is disabled, the device will consume less current.

FIGURE 1-5: MCP2120 ENABLE/DISABLE

In most cases, this jumper will be open. It may be closed to test system operation when 

the MCP2120 is disabled. The Host Controller board may control the operation of the 
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FIGURE 1-6: HOST CONTROLLER DISABLING THE MCP2120  
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Getting Started
1.3.6 MCP2150 Developer’s Board Features

The MCP2150 Developer’s Board, as shown in Figure 1-7, has the following hardware 

features:

1. On-board +5V regulator for direct input from 9V, 750 mA AC/DC wall adapter or 

9V battery.

2. Hooks for a +5V, 750 mA regulated DC supply.

3. DB-9 connector and associated hardware for direct connection to MCP2150 

UART (DB-9 interface requires RS-232 signal levels).

4. Ten-pin header connection to UART interface (Header requires TTL level 

signals).

5. Three jumpers to select source of UART signals. Either DB-9 connector or the 

eight-pin header.

6. Two jumpers to select desired baud rate.

7. Green power-on indicator LED.

8. Green LED for Carrier Detect.

9. Two IR Transceiver options (two jumpers select transceiver).

10. Jumper to disable MCP2150 device operation.

11. Hardware Baud selection.

FIGURE 1-7: MCP2150 BOARD HARDWARE

Note: A schematic of the MCP2150 Developer’s Board is shown in Figure A-6
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1.3.7 Selecting UART Source and Optical Transceiver Interface

Figure 1-8 shows two sets of jumpers used to route signals to and from the MCP2150.

Jumpers J2, J3 and J4 are used to determine the source of the signals used by the 

UART interface. When the header has the pins closest to the “DB9” label jumpered to 

the center pin, the DB9 is the source of the UART signal. When the header has the pins 

closest to the “Header” label jumpered to the center pin, the four-pin header is the 

source of the UART signal.

Jumpers J7 and J8 are used to determine the source and destination of the IrDA sig-

nals used by the interface between the MCP2150 and Optical Transceiver. When the 

header has the pins closest to the “Integrated Transceiver” label jumpered to the center 

pin, the integrated transceiver is used. When the header has the pins closest to the 

“Component Transceiver” label jumpered to the center pin, the component transceiver 

logic is used.

FIGURE 1-8: MCP2150 SELECTING SOURCES 
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1.3.8 Selecting Baud Rate

Figure 1-9 shows the two Baud Rate Select jumpers (JP2:JP1) and the baud rate. 

Table 1-2 shows the baud rates for some crystal frequencies.

FIGURE 1-9: MCP2150 BAUD RATE 
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BAUD1:BAUD0 Baud Rate @ 11.0592 MHz Bit Rate 

00 9600 FOSC / 1152

01 19200 FOSC / 576

10 57600 FOSC / 192

11 115200 FOSC / 96

These three jumpers select the Baud Rate 

JP2:JP1 

9600 

19200 

57600 

JP2:JP1 

115200 

MCP2150 Dev Board
02-01609 Rev. 1

D
B
9

J1

J4

H
e
a
d
e
r

T
X

R
X

R
T
S

+5VGND

J3

J2

C
T
S

D
T
R

D
S
R

C
D

R
I

G
N
D

+
5

R11 C16

Integrated
Transceiver

R13

JP2 JP1 BAUD
0
0
1
1

0
1
0
1

9600
19200
57600
115200

Component
Transceiver

J8J7

U5

J6

J5

BT1

C17

D4

C
1
4

C15

CR1

C16 C12

U2
Y1

C1 C4 C2

C3 U1

C10
D7

CD

R2 JP3

(MCP2150)
Open=Enabled

R4 R3

JP2 JP1

C8

C7

D3
R7

Power
C5

U4
R5

C11

R9

R8
D2D5

R1

C
9

U3

R6 C13

C
6

R14

R10

D1

D6

U6
© 2005 Microchip Technology Inc. DS51246C-page 15



MCP2120/MCP2150 Developer’s Kit User’s Guide
1.3.9 Disabling the MCP2150

Figure 1-10 shows the jumper (JP3) which will enable or disable the MCP2150 device. 

When the MCP2150 is disabled, the device will consume less current. 

FIGURE 1-10: MCP2150 ENABLE/DISABLE

In most cases, this jumper will be open. It may be closed to test system operation 

when the MCP2150 is disabled. The Host Controller board may control the operation 

of the MCP2150 by connecting a signal to the JP3 header as shown in Figure 1-11.

FIGURE 1-11: HOST CONTROLLER DISABLING THE MCP2150 
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1.4 SYSTEM CONFIGURATIONS

There are five configurations that one would use for initial evaluation of these two 

Developer’s Boards. These configurations are shown in Table 1-3.

The Host controller for each board can be either a Personal Computer (PC) or another 

system connected to the Host header. The PC operating system (OS) may be any 

desired OS that has a terminal emulation program which can connect to the serial port 

and can treat the IR port as a virtual serial port. For our tutorial, we will use the Windows 

9x OS.

TABLE 1-3: CONFIGURATIONS FOR EVALUATION OF DEVELOPER’S 
BOARDS

Developer’s Board #1 Developer’s Board #2

1. MCP2120 Dev Board (ASCII) ↔ MCP2120 Dev Board (ASCII)

2. MCP2120 Dev Board (IR Driver) → MCP2120 Dev Board (IR Driver)

3. MCP2150 Dev Board (ASCII) ↔ MCP2120 Dev Board (IR Driver)

4. MCP2120 Dev Board (IR Driver) → IrDA standard port (Palm Pilot, cell phone, ...)

5. MCP2150 Dev Board (ASCII) → IrDA standard port (Palm Pilot, cell phone, ...)

Note 1: Windows NT® 4.x (and lower) does not support the IrDA standard 

functionality. Third Party programs exist, but are not supported or 

recommended by Microsoft, so are also not recommended by Microchip.

2: Windows 2000 does support the IrDA standard, but does not treat the IR 

port as a virtual serial port. This means that you cannot access the IR port 

as a serial port. This causes issues with some terminal emulation pro-

grams, such as Hyperterminal. Windows 2000 considers the IrDA port to 

be a network device. Applications that can access a network service 

through a network protocol (i.e., TCP/IP) can use the MCP2120 

Developer’s Board using the appropriate Windows 2000 driver.
© 2005 Microchip Technology Inc. DS51246C-page 17
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1.4.1 Configuration 1

This is the typical mode that will be used for the two MCP2120 Developer’s Board. In 

this configuration, the MCP2120 board receives data as a single ASCII byte. This byte 

is then translated to the IR data format, and transmitted out of the selected optical 

transceiver logic.

The host interface can be from either the DB-9 (PC or other UART) or the Header.

A PC running a terminal emulation program, such as Hyperterminal, connected to the 

serial port will create this ASCII data stream. The PC can then be connected to the 

Developer’s Board DB-9 connector.

1.4.2 Configuration 2

This is used to view the effects of the IrDA standard stack protocol on the data stream. 

This can be used to better understand the construction of the IrDA standard data 

packet, or as a diagnostic tool.

The host interface can be from either the DB-9 (PC or other UART) or the Header.

A PC running a terminal emulation program, such as Hyperterminal, connected to the 

IR port as a virtual serial port will create this ASCII data stream. The PC can then be 

connected to the MCP2120 Developer’s Board DB-9 connector.

1.4.3 Configuration 3

This is the configuration when using one MCP2120 Developer’s Board and one 

MCP2150 Developer’s Board. 

The MCP2150 Developer’s Board can have the host interface be from either the DB-9 

(PC or other UART) or the Header.

The MCP2120 Developer’s Board would interface to a PC running a terminal emulation 

program, such as Hyperterminal, that connects the IR port to a virtual serial port.

Developer’s Board #1 Developer’s Board #2

MCP2120 Dev Board (ASCII) ↔ MCP2120 Dev Board (ASCII)

Developer’s Board #1 Developer’s Board #2

MCP2120 Dev Board (IR Driver) → MCP2120 Dev Board (IR Driver)

Developer’s Board #1 Developer’s Board #2

MCP2150 Dev Board (ASCII) ↔ MCP2120 Dev Board (IR Driver)
DS51246C-page 18 © 2005 Microchip Technology Inc.
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1.4.4 Configuration 4

This configuration is used to evaluate the MCP2120 for an IrDA system, where the Host 

Controller is responsible for the IrDA protocol stack.

The MCP2120 Developer’s Board interfaces to a PC running a terminal emulation 

program, such as Hyperterminal, that connects the IR port to a virtual serial port.

1.4.5 Configuration 5

This configuration is used to evaluate the MCP2150 for adding the IrDA feature to a 

system. The Host controller only needs to send and receive the required ASCII data, 

while the MCP2150 handles the IrDA standard protocol stack.

The MCP2150 Developer’s Board can have the host interface be from either the DB-9 

(PC or other UART) or the Header.

1.5 PC REQUIREMENTS

The PC used has three main requirements. These are:

1. Standard Serial Port.

2. Terminal Emulation Program.

3. IrDA standard driver installed, which treats the IR port as a virtual serial port.

A non-legacy-free Intel compatible model with Windows 9x/2000 Operating System 

(OS) would meet these requirements. The Windows OS includes a Terminal Emulation 

program called Hyperterminal. Section 2.5 shows instructions to configure 

Hyperterminal and demonstrate the Developer’s Boards.

Developer’s Board #1 Developer’s Board #2

MCP2120 Dev Board (IR Driver) → IrDA standard port (Palm Pilot, cell phone, ...)

Developer’s Board #1 Developer’s Board #2

MCP2150 Dev Board (ASCII) → IrDA standard port (Palm Pilot, cell phone, ...)

Note 1: Windows 2000 does support the IrDA standard, but does not treat the IR 

port as a virtual serial port. This means that you cannot access the IR port 

as a serial port. This causes issues with some terminal emulation pro-

grams, such as Hyperterminal. Windows 2000 considers the IrDA port to 

be a network device. Applications that can access a network service 

through a network protocol (i.e., TCP/IP) can use the MCP2120 

Developer’s Board using the appropriate Windows 2000 driver.
© 2005 Microchip Technology Inc. DS51246C-page 19
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MCP2120/MCP2150
DEVELOPER’S KIT USER’S GUIDE

Chapter 2.  MCP2120 Tutorial
2.1 INTRODUCTION

This chapter covers a tutorial for using the MCP2120 Developer’s Board.

2.2 HIGHLIGHTS

Items discussed in this chapter include:

• MCP2120 Tutorial Setup

• Hardware Setup

• Setting Up the Terminal Program

• Transmitting/Receiving Data

2.3 MCP2120 TUTORIAL SETUP

This tutorial will use both MCP2120 Developer’s Boards. The system will operate at 

9600 Baud. Each board will be connected via the UART to the serial port of a personal 

computer (PC). This means that either two PCs are required, or a PC with two serial 

ports, as shown in Figure 2-1. It is assumed that two PCs will be used, and that each 

PC will have the Terminal Emulation program configured identically.

FIGURE 2-1: SYSTEM BLOCK DIAGRAM
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2.4 HARDWARE SETUP

2.4.1 Oscillator

The crystal oscillator has pin receptacles to allow the changing of the MCP2120 

oscillator frequency. For the tutorial, we will be using a crystal frequency of 

7.3728 MHz. This crystal frequency is shipped in the kit.

2.4.2 Board Jumpers

The MCP2120 and MCP2150 Developer’s Boards may use one of two host interfaces, 

the DB-9 interface to connect to a PC, or the header to connect to a controller board.

For the tutorial, the host signal will come from the DB-9 connector and the infrared data 

signals will interface to the Integrated Optical Transceiver. Figure 2-2 shows how the 

two 3-pin jumpers need to be connected for this configuration.

FIGURE 2-2: MCP2120 DEVELOPER’S BOARD COMPONENT LAYOUT
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Figure 2-3 shows the three Baud Rate Select jumpers (JP3:JP1) and the baud rate 

formula that is specified (baud rate dependant on MCP2120 operational frequency). 

The tutorial requires these jumpers to be open for a baud rate of 9600, when the 

crystal frequency is 7.3728 MHz.

FIGURE 2-3: MCP2120 BAUD RATE 
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Figure 2-4 shows jumpers JP4 and JP5 and their state. For the tutorial, both of these 

jumpers are required to be open.

FIGURE 2-4: MCP2120 UART MODE AND ENABLE MODE
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2.5 SETTING UP THE TERMINAL PROGRAM

Windows 95 Operating System (OS) comes with a Terminal Emulation program called 

Hyperterminal. This tutorial uses this program to demonstrate the operation of the 

MPLAB C30 Developer’s Kit boards. 

To open Hyperterminal, select Start > Programs > Accessories and select the Hyper-

terminal folder. Then double click the program file Hypertrm.exe. to start Hyperterminal. 

Figure 2-5 shows the initial screen once the Hyperterminal program is open. You will 

then need to select a name for this configuration.

FIGURE 2-5: HYPERTERMINAL® OPENING SCREEN

For the initial test, we will set up the system to operate at 9600 baud. Type the name 

as shown in Figure 2-6 and select any icon. Click OK.

FIGURE 2-6: CHOOSING NAME AND ICON
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The menu in Figure 2-7 appears. You will need to select the port your serial port is on 

(Connect using). In our case, we are using COM1. Click OK.

FIGURE 2-7: SELECTING COMMUNICATIONS (COM) PORT

The Default settings for COM1 are displayed in Figure 2-8.

FIGURE 2-8: HYPERTERMINAL® DEFAULT COM PORT SETTINGS
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The COM port settings need to be modified so the Bits per second is “9600” and the 

Flow Control is “None”, as shown in Figure 2-9. Click OK when done.

FIGURE 2-9: DESIRED HYPERTERMINAL® COM PORT SETTINGS

The terminal window opens connected to the serial port as shown in Figure 2-10.

FIGURE 2-10: HYPERTERMINAL® SCREEN AFTER INITIAL SETUP 
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When the characteristics of the Hyperterminal session need to be modified, the 

program should be disconnected from the port. To disconnect, click on the icon with the 

handset with the down arrow onto the phone base as shown in Figure 2-11.

FIGURE 2-11: DISCONNECTING HYPERTERMINAL®

To modify the properties of this Hyperterminal session, select File > Properties as 

shown in Figure 2-12.

FIGURE 2-12: SELECTING HYPERTERMINAL® PROPERTIES MENU
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The Hyperterminal Properties window will appear as shown in Figure 2-13. Clicking the 

“Configure...” button will open the COM Properties window shown in Figure 2-14.

FIGURE 2-13: HYPERTERMINAL® PROPERTIES MENU (CONNECT TO)

Verify the settings are as desired. If not, change the settings to match the settings in 

Figure 2-14. Click the OK button and you will return to the window shown in 

Figure 2-13.

FIGURE 2-14: CONFIGURE CONNECTION MENU
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Click on the Settings tab. Figure 2-15 shows the default settings. The “Backscroll 

buffer lines” setting can be modified to 0, if desired. This will make viewing information 

in the Hyperterminal window more convenient.

FIGURE 2-15: HYPERTERMINAL® PROPERTIES MENU (SETTINGS)

Clicking on the “Input Translation...” button will bring up the following window. Click 

Cancel to close this window.

FIGURE 2-16: INPUT TRANSLATION MENU
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Clicking on the “ASCII Setup...” button will bring up the ASCII Setup window. Make the 

changes as shown in Figure 2-17 by checking the “Echo typed characters locally” 

setting. Click OK to apply these changes and close the window.

FIGURE 2-17: ASCII SETUP MENU

2.6 TRANSMITTING/RECEIVING DATA

Now both PCs should have their Hyperterminal program running in the connected 

mode with the same COM port settings. See Figure 2-9.

Each MCP2120 Developer’s Board should be powered. Use the pair of 18″ (45 cm) 

power jumper cables to power MCP2120 Developer’s Board #2 from MCP2120 

Developer’s Board #1. Optionally, MCP2120 Developer’s Board #2 could be powered 

from a 9V battery. When the MCP2120 Developer’s Board is powered, the green LED 

(labeled D3) will be on.

Each MCP2120 Developer’s Board should be connected to their respective PC serial 

port, so that Hyperterminal can communicate to the board.

The MCP2120 Developer’s Board should be oriented so that the integrated optical 

transceivers are aligned with each other (as shown in Figure 2-18). For the initial 

communication between the two boards, the MCP2120 Developer’s Boards should be 

approximately 6” (15 cm) apart.

Type a string of characters in the Hyperterminal window on PC #1. This same character 

sting should appear in the Hyperterminal window of PC #2. Typing a string of charac-

ters in the Hyperterminal window on PC #2 should have the same character string 

appear in the Hyperterminal window of PC #1. Congratulations! You may now start 

modifying the system to evaluate/test the operation of the MCP2120 and MCP2120 

Developer’s Board.
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FIGURE 2-18: MCP2120 TUTORIAL SYSTEM

2.6.1 System Debug Tips

If you are not getting communications between the two boards, some debugging is in 

order. Here are some suggested steps:

• Verify that the Hyperterminal programs are set up correctly

• Verify that both Hyperterminal sessions are “connected”

• Verify that the MCP2120 Developer’s Boards are powered

• Verify that the MCP2120 Developer’s Boards are set up correctly

If that review does not locate the issue, then more in depth debugging is required. 

These steps require an oscilloscope. A digital 4-channel oscilloscope is recommended. 

By typing a data byte into Hyperterminal on the PC, the oscilloscope can be used to 

determine where in the system the data byte was “lost”.

Figure 2-19 and Figure 2-20 shows a debug flow to help troubleshoot the communica-

tions between the two MCP2120 Developer’s Boards. Figure 2-19 shows the steps for 

the transmit side of System #1 (PC #1 and MCP2120 Developer’s Board #1). If it 

appears that the TXIR signal is correct, then the receive side needs to be validated. 

Figure 2-20 shows the steps for the receive side of System #2 (PC #2 and MCP2120 

Developer’s Board #2).

These steps can then be used to debug the transmit side of System #2 and the receive 

side of System #1.
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FIGURE 2-19: DEBUG FLOWCHART – MCP2120 DEVELOPER’S BOARD
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FIGURE 2-20: DEBUG FLOWCHART – MCP2120 DEVELOPER’S BOARD
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Chapter 3.  MCP2150 Tutorial
3.1 INTRODUCTION

This chapter covers a tutorial for using the MCP2150 Developer’s Board.

3.2 HIGHLIGHTS

Items discussed in this chapter include:

• MCP2150 Tutorial

3.3 MCP2150 TUTORIAL

This tutorial was not available for this revision of the MCP2120/MCP2150 Developer’s 

Kit User’s Guide. Please check in the Development Tools section of the Microchip web 

site (www.microchip.com) for revision D of the User’s Guide. Revision D is planned 

to include the tutorial on using the MCP2150 Developer’s Board with an MCP2120 

Developer’s Board. 

Information on Microchip Development Tools can be located on the web site by using 

the Navigate window and selecting Developer’s Tool Box > Development Tools.
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Chapter 4.  Using a PICDEM™ 1 or PICDEM 2 Board as Host
4.1 USING THE PICDEM 1 BOARD

The PICDEM 1 board may be used as the host controller in an IrDA standard 

compatible system. PortB can be used to display received characters, while any of 

the other ports would be used for the UART and control signals. A PICmicro® 

microcontroller may be selected that has a hardware UART, or the UART functionality 

may be implemented in software.

Figure 4-1 shows the parts layout (silk-screen) for the PICDEM 1 board.

FIGURE 4-1: PICDEM™ 1 PARTS LAYOUT

Note 1: U1 is for use with any 40-pin PIC17C4X device.

2: U2 is for use with any 18-pin PIC16C5X, PIC16CXXX device.

3: U3 is for use with any 28-pin PIC16C5X, PIC16CXXX device.
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4.2 APPLICATION NOTES

There are two Application Notes that show how to use the PICDEM 1 Board as a Host 

controller.

AN756, “Using the MCP2120 for Infrared Communication”, DS00756, uses the 

MCP2120 Developer’s Board and has two code examples. The first is using a 

PIC16F84 with the MCP2120 Developer’s Board in Hardware Baud mode. In this 

mode, only two signals need to be interfaced. The RX and TX signal. The second code 

example is also using a PIC16F84 with the MCP2120 Developer’s Board in Software 

Baud mode. In this mode, four signals need to be interfaced; RX, TX, MODE and RTS 

(used to reset the MCP2120).

AN758, “Using the MCP2150 to Add IrDA™ Standard Wireless Connectivity”, 

DS00758, uses the MCP2150 Developer’s Board and has one code example. For this 

application, seven signals need to be interfaced; RX, TX, DSR, DTR, CTS, RTS and 

CD.

4.2.1 For Additional PICDEM 1 Information

Additional information can located on the Microchip web site (www.microchip.com). 

Information on Microchip Development Tools can be located by using the Navigate 

window and selecting Developer’s Tool Box > Development Tools.

The PICDEM 1 User’s Guide literature number is DS33015, and the PICDEM 1 kit can 

be ordered with part number DM163001.

4.3 USING THE PICDEM 2 BOARD

The PICDEM 2 board may be used as the host controller in an IrDA standard compat-

ible system. PortB can be used to display received characters, while any of the other 

ports would be used for the UART and control signals. A PICmicro microcontroller may 

be selected that has a hardware UART, or the UART functionality may be implemented 

in software.

Figure 4-2 shows the parts layout (silk-screen) for the PICDEM 2 board.
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FIGURE 4-2: PICDEM™ 2 PARTS LAYOUT

4.3.1 Application Notes

Currently there are no Application Notes that use the PICDEM 2 Board as a Host 

controller. The examples shown for the PICDEM 1 board can be easily modified to have 

the PICDEM 2 board operate as the Host controller.

4.3.2 For Additional PICDEM 2 Information

Additional information can located on the Microchip web site (www.microchip.com). 

Information on Microchip Development Tools can be located by using the Navigate 

window and selecting Developer’s Tool Box > Development Tools.

The PICDEM 2 User’s Guide literature number is DS30374, and the PICDEM 2 kit can 

be ordered with part number DM163002.
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Appendix A. Hardware Detail
A.1 INTRODUCTION

The MCP2120/MCP2150 Developer’s Board hardware is intended to illustrate the ease 

of use of Microchip’s infrared data communication solutions. The Developer’s Board 

features the following hardware elements.

A.2 POWER SUPPLY

There are three ways to supply power to the MCP2120/MCP2150 Developer’s Board:

• A 9V battery can be plugged into BT1.

• A 9V, 750 mA unregulated AC or DC supply can be plugged into J5.

• A +5V, 750 mA regulated DC supply can be connected to the two pins provided, 

labled +5V and GND. A pair of 18″ (45 cm) cables are provided to allow one board 

to power another.

A.3 POWER INDICATOR

One green LED indicates whether there is power applied to the MCP2120 and 

MCP2150 Developer Boards (LED lit) or not (LED off).

A.4 RS-232 SERIAL PORT

A.4.1 MCP2120 Developer’s Board

A MAX232 compatible level shifting IC has been provided with all necessary hardware 

to support connection of an RS-232 host through the DB-9 connector. The port can be 

connected to a PC using a straight through cable. Refer to the MCP2120 Data Sheet  

(DS21618) for more information.

A.4.2 MCP2150 Developer’s Board

A MAX3238E compatible level shifting IC has been provided with all necessary 

hardware to support connection of a RS-232 host through the DB-9 connector. The port 

can be connected to a PC using a straight through cable. Refer to the MCP2120 Data 

Sheet for more information.
© 2005 Microchip Technology Inc. DS51246C-page 41



MCP2120/MCP2150 Developer’s Kit User’s Guide
A.5 JUMPERS

Jumpers are used to allow the Developer’s Board to be configured into the different 

modes that are possible. These modes include:

• Selection of baud rate

• Source of host signals

• Source of optical transceiver signals

• Device enable signal for power down operation

A.5.1 MCP2120 Developer’s Board

The MCP2120 Developer’s Board has the following jumpers:

1. Two jumpers to select source of UART signals. Either RS-232C socket or the 

four-pin header.

2. Three jumpers to select desired baud rate.

3. Two jumpers to select IR Transceiver options.

4. Jumper to disable device operation.

5. Jumper for Software Baud control when using RS-232C interface.

FIGURE A-1: MCP2120 DEVELOPER’S BOARD HARDWARE
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A.5.2 MCP2150 Developer’s Board

The MCP2150 Developer’s Board has the following jumpers:

1. Three jumpers to select source of UART signals. Either RS-232C socket or the 

eight-pin header.

2. Two jumpers to select desired baud rate.

3. Two jumpers to select IR Transceiver options.

4. Jumper to disable device operation.

FIGURE A-2: MCP2150 DEVELOPER’S BOARD HARDWARE
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A.6 OSCILLATOR OPTIONS

The MCP2120 can be operated at different frequencies, while the MCP2150 only 

operates at a single fixed frequency.

A.6.1 MCP2120 Developer’s Board

The MCP2120 Developer’s Board crystal has pin receptacles so that crystal 

frequencies can easily be changed. Table A-1 shows the baud rates for a given crystal 

frequency, based on the state of the BAUD2:BAUD0 pins.

TABLE A-1: CRYSTAL FREQUENCY / BAUD RATE 

A.6.2 MCP2150 Developer’s Board

The MCP2150 Developer’s Board requires a fixed frequency crystal (11.0592 MHz). 

TABLE A-2: CRYSTAL FREQUENCY / BAUD RATE 

BAUD2:BAUD0 Bit Rate

FOSC Frequency (MHz)

0.6144(1) 2.000 3.6864 4.9152 7.3728 14.7456(2) 20.000(2) 

000 FOSC / 768 800 2604 4800 6400 9600 19200 26042

001 FOSC / 384 1600 5208 9600 12800 19200 38400 52083

010 FOSC / 192 3200 10417 19200 25600 38400 78600 104167

011 FOSC / 128 4800 15625 28800 38400 57600 115200 156250

100 FOSC / 64 9600 31250 57600 78600 115200 230400 312500

Note 1: An external clock is recommended for frequencies below 2 MHz.

2: For frequencies above 7.5 MHz, the TXIR pulse width (MCP2120 Data Sheet 

electrical specification parameter IR121) will be shorter than the minimum pulse width 

of 1.6 µs in the IrDA standard specification.

BAUD1:BAUD0 Bit Rate FOSC Frequency - 11.0592 MHz

00 FOSC / 1152 9600

01 FOSC / 576 19200

10 FOSC / 192 57600

11 FOSC / 96 115200
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A.7 BOARD LAYOUT

Figure A-3 shows the component layout (silkscreen) for the MCP2120 Board.

FIGURE A-3: MCP2120 DEVELOPER’S BOARD COMPONENT LAYOUT 

Figure A-4 shows the component layout (silkscreen) for the MCP2150 Board.

FIGURE A-4: MCP2150 DEVELOPER’S BOARD COMPONENT LAYOUT 
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A.8 SCHEMATICS

Figure A-5 shows the schematic for the MCP2120 Developer’s Board. Figure A-6 

shows the schematic for the MCP2150 Developer’s Board.

FIGURE A-5: MCP2120 DEVELOPER’S BOARD SCHEMATIC
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FIGURE A-6: MCP2150 DEVELOPER’S BOARD SCHEMATIC
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